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SECTION  1 INTRODUCTION 

 

1.0 INTRODUCTION 

 

This section provides an overview of the Enhanced Automated Graphical Logistics Environment 

Publishing System (EAGLE Publishing System or EPS). This section will present design intent, 

integration with EAGLE and general conventions that will be used throughout the workbook, as 

well as notation for different sections of the EAGLE Publishing System (EPS). 

 

This manual is intended to be utilized by Project Administrators as an aid in setting up Projects 

and User roles.  It also will aid lead persons in assigning authoring authority and tracking project 

metrics.  Additionally, the workbook will be utilized in the classroom setting for users to perform 

step by step workflow and publishing. 

 

 

1.1 PURPOSE OF DESIGN 

 

EAGLE Publishing System has been designed to produce ASD S1000D compatible Data Modules 

as well as MIL -STD 40051 Work Packages and MIL-PRF-87929 Appendix I Work Packages.  

EPS can operate independently of the EAGLE LSAR Database or be linked to certain 

Functionality depending upon user needs. 

 

1.1.1 EPS Standalone 

 

With System Defaults set to Project needs EPS may be launched Standalone and perform per 

S1000D.  

 

1.1.2 EPS and EAGLE 

 

Utilizing the EAGLE LSAR Functionality, ASD S1000D DMs and MIL-STD 40051 Work and 

MIL -PRF-87929C Appendix I Work Packages may be produced with LSAR Task Data.  For 

procedural DMs, the basic tools of EAGLE that incorporate Task, Subtask and Subtask Narrative 

capability as well as provide the supporting data, and other requirements are all accessible. 

 

Many of the sections in this Workbook make reference to the ñEAGLE Workbookò.  This 

workbook will be made available to all students in EPS Training, and is available in PDF on the 

EAGLE website.  In Section 5.14 the EAGLE Illustrated Parts Data for ASD S1000D Workbook 

is also referenced. 

 

1.1.3 EPS Databases 

 

EPS will perform per DEF-STAN 00-60 and MIL-STD-1388-2B.  As part of Project Setup, setting 

System Defaults is covered in Section 2.2.  
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1.2 EAGLE PUBLISHING SYSTEM NOTATIONS 

 

Before using the EAGLE Publishing System, it is important to understand the terms and notation 

conventions used in the documentation. 

 

1.2.1 General Conventions 

 

¶ The word ñchooseò is used for carrying out a menu command or a command button in a 

dialog box. 

¶ The word ñselectò is used for highlighting the object that the next action is to affect, and 

for selecting a specific dialog box option. 

¶ Commands that are chosen are given with the menu name preceding the command name. 

For example, the phrase ñchoose File>>Open Project éò means choose the Open 

Projecté command from the File menu. This naming convention describes the sequence 

that should be followed in choosing a command --- select the menu first and then choose 

the command. 

¶ Data fields that should be entered by the user into the application are enclosed in single 

quotation marks preceded by the words ñtype inò or ñenterò 

¶ The word ñSTEPò is used to indicate that the following instructions are steps that should 

be performed by the user while taking the training class. Each step or user action is 

preceded by a bullet symbol ( ǒ ) 

¶ Button names, key stroke combinations, menu items and tabs are in bold print to help 

emphasize what is being typed in or selected with the mouse. 

 

 

1.2.2 Mouse Conventions 

 

¶ The word ñClickò means to press and immediately release the mouse button without 

moving the mouse. For example, ñClick OKò 

¶ The phrase ñDouble-clickò means to click the mouse button twice in rapid succession. 

For example, ñDouble-click the EAGLE Publishing System icon to start EAGLE 

Publishing Systemò. 

¶ The phrase ñdragò means to press and hold the mouse button while you move the mouse; 

then, release the button. 
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1.2.3 Keyboard Conventions 

 

¶ Key names match the names shown on most keyboards and appear in bold caps. For 

example the Shift key appears as SHIFT  

¶ A plus (+) sign used between two key names indicates both keys must be pressed at the 

same time. For example, ñPress SHIFT+F1ò means press the SHIFT  key and hold it 

down while you press the F1 key. 

¶ A comma (,) between two key names indicates that those keys must be pressed 

sequentially. For example, ñPress ALT+F,Oò means press the ALT  key and the F key at 

the same time and release them, and then press the O key and release it. 

¶ Ctrl+Clic k is used to Select specific records.  Hold down the CTRL  key and left Click 

with the mouse. 

 

1.2.4 Window Conventions 

 

¶ Response windows cannot be closed using the normal window conventions. They will 

have an Ok or Cancel button for response, and they will close upon completion. 

¶ Checkboxes are square objects on a window that allow selection of certain criteria. They 

are designed so that more than one checkbox can be checked at a time. 

¶ Radio buttons are circular objects on a window that allow selection of certain criteria. 

They are designed so that only one radio button can be selected at a time. 

¶ Tabs exist on a window providing methods of accessing different areas of the window. 

When a tab is clicked on, the window changes to reflect the tab information. 
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1.3 LOGGING IN TO THE EAGLE PUBLISHING SYSTEM  

 

 

 

Figure 1.  EAGLE Login window 

 

 

1.3.1 Logging in  

 

To launch the EAGLE Publishing System you may Select Programs>>EAGLE Publishing System 

from the START Menu. 

 

At the current time, the EPS executable ( ) resides in the EAGLE Install 

Directory.  A shortcut Icon can be utilized to launch EPS. 

 

As shown in Figure 1, a User Name: of ñSTUDENTXXò and a User Password: have been entered.  

This data will be used to log the User into the specific database.  User Maintenance is covered in 

SECTION  3. 
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1.4 EAGLE PUBLISHING SYSTEM SCREEN SECTIONS/REGIONS 

 

1.4.1 EPS Main Screen 

 

The Main Screen (Figure 2) of the EAGLE Publishing System refers to the entirety of the 

program window. This will be referenced when noting locations of sections/regions within the 

window or when referencing the program itself. 

 

 

 

Figure 2.  EAGLE Publishing System - Main Screen 

 

1.4.2 EPS Main Toolbar 

 

The Main Toolbar  (Figure 3) of the EAGLE Publishing System includes all the menu options 

required for administrative and authoring functions.  Along with the classic text based toolbar 

present on all Windows applications, there are also hot-buttons present for quick access to some of 

the more commonly used functions.  Scrolling over the Icons will provide a description of the icon 

function. 
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Figure 3.  EPS Main Screen - Main Toolbar 

 

 

1.4.2.1 EPS Main Toolbar Icon Display 

 

As shown in Figure 3, the Main Toolbar has several icons to the left of the Filters and Clear All  

function icons.  This display is editable by choosing Tools>>Options as shown in Figure 4.  Note 

the Admin Options selection.  This is only available when Logged in as EAGLE. 

 

 

Figure 4.  Main Toolbar ï Tools>>Options 

 

As shown in Figure 5, the lower region of the window contains checkboxes that may be checked 

or unchecked.  Checking the box(s) will enable the icon(s) to be displayed.  Un-checking the 

box(s) will disable the icon(s) on the Main Toolbar Display. 

 

The Options window and the various tab selections are covered in detail in Section 3.4 



EAGLE Publishing System Workbook for S1000D SECTION 1  INTRODUCTION 

1-9 

 

 

Figure 5.  Tools>>Options ï Basic Tab 
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1.4.3 EPS Main Screen Data Grid 

 

 

 

Figure 6.  EPS Main Screen ï Data Grid 

 

 

1.4.3.1 EPS Main Screen Data Grid Appearance 

 

 

 

 

Figure 7. EPS Main Screen ï Tools>>Options 
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Figure 8.  Tools>>Options ï Appearance Tab 

The appearance of the Main Screen Data Grid can be modified as shown in Figure 8.  This display 

is editable by choosing Tools>>Options>>Appearance. 
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1.4.4 EPS Project Structure Navigator 

 

Located on the left side of the EAGLE Publishing System main screen is the Project Structure 

Navigator (Figure 9).  This Project Structure Tree functions as an organized navigation control for 

the current project.  This Navigator provides the ability for the user to build Data Module Codes 

(DMCs) and Information Control Numbers (ICNs) by ñdrilling downò through the Standard 

Numbering System (SNS). 

 

Note: In instances where a user is assigned more than one Project, multiple tabs will appear at 

the top of the tree structure. These tabs are used to switch between the assigned Projects. 

 

 

 

Figure 9.  Main Screen ï Project Structure Navigator 
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1.4.4.1 Navigating the Standard Numbering System (SNS) 

 

The SNS consists of three groups of characters intended to provide standardization in the 

arrangement or addressing of the Project. Maintained SNSs are developed for air vehicles, engines 

and equipment, tactical missiles and others.  The Standard Numbering System (SNS) is the core 

element of the DMC that describes the subject or item that the data pertains to. 

 

Figure 10 is an example of the EPS Tree structure and navigating down through the SNS (05-20-

00) utilizing the expand icons for Project ñTRAININGXXò, MI  ñBICYCLEXXò, SDC ñAAAAò. 

 

 

 

 

Figure 10.  EPS Tree Structure ï Navigating SNS 
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1.4.5 EPS Main Tab Control 

 

Located above the context sensitive active screen is the main tab control (Figure 11) dictating 

which screen is currently active.  These tabs are titled ñData Modulesò, ñCompletion Statusò, 

ñEntitiesò, and ñPublishingò. The Main Tab Control allows for switching between these four 

screens.  Utilize the scroll bar at the bottom of the screen to view the additional column data for 

each selected tab. 

 

 

 

Figure 11.  Main Screen - Main Tab Control  

 

1.4.5.1 EPS Data Modules (DMs) Tab 

 

The Data Modules (DMs) tab (Figure 12) is used in the control and management of individual data 

modules pertaining to the current project.  This tab is accessed through the Main Tab control, and 

its functions are addressed in Section 4 of this workbook. When the Data Modules tab is selected, 

if DMs exist for the chosen Project, they will be displayed in the ñData Gridò 

 

 

 

Figure 12.  Data Modules Tab Selected ï Brex DM Shown in Data Grid 
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Figure 13.  Data Modules Tab ï Bottom of Screen 

 

Note:  With the DMs Tab or the Completion Status Tab selected icons are displayed at the bottom 

of the screen (Figure 13) that are utilized to indicate the status of the DMs 

 

 

1.4.5.2 EPS Completion Status Tab 

 

The Completion Status tab (Figure 14) is the second tab in the main tab control.  From here, the 

overall progress of the authored data module can be monitored.  Listed by Data Module Code and 

filtered by the SNS, the completion status tab lists important information including the percent 

complete, the actual hours in production, and timetables of when each DM was started, reviewed 

and completed. 

 

 

 

Figure 14.  Completion Status Tab Selected ï Data Grid Shown 
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1.4.5.3 EPS Entities Tab 

 

The Entities tab (Figure 15) is the third tab in the main tab control.  It includes all functions 

necessary for adding, deleting and managing images and special characters to be used throughout 

the project 

 

 

Figure 15.  Entities Tab Selected ï Data Grid and Preview Shown 

 

In this example, a Preview of the entity is displayed as a result of using the Preview Options drop 

down and selecting ñEnable Entity Previewò as shown in Figure 16. 

 

 

 

Figure 16.  Entities Tab ï Enable Entity Preview 
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1.4.6 EPS Publishing Tab 

 

 

 

Figure 17.  Publishing Tab ï New Selected 

 

Figure 17 is shown with the Publishing Tab selected, and after the New button has been pressed.  

The left side of the screen has two drop down lists, one to select End Item and the other to select 

the Project.   

The left side of the screen also contains the Structure Navigator which can be used to filter the 

Data Module(s) displayed in the center of the screen. 

The right side of the screen is used for Publication Module identification and DM selection. 

 

 

1.5 PROJECTS 

 

S1000D under Basic Definitions defines Project as the ñtask to develop, maintain and dispose of 

the Productò.  On a smaller scale, in SECTION  2 we will show how to set up a Project in EPS and 

how we manage that project through its lifecycle.  
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1.6 WORKFLOW AND STATUS 

 

Development of the Data Module is controlled through a specific predetermined workflow.  While 

under construction and revision, specific stages accurately describe the state of each independent 

DM allowing for asynchronous development.  It is controlling this workflow that makes each user 

role so important.  It is good practice to assign one person to author a set of data modules, while 

another person does all quality checking.  However if staff is limited, multiple user names can be 

used to fulfill all roles. 

 

The following section outlines the workflow a single Data Module could experience through its 

lifecycle. 
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Figure 18.  EPS for S1000D Workflow and Status 
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1.6.1 The Completion Status Tab 

 

The completion status tab is used to track the progress of the authoring of all Data Modules.  

Additionally, the completion status tab may be used by a user with the EAGLE_TM_MGR_ROLE 

to set estimated start and completion dates for each DM. 

 

STEP To set estimated start and completion dates for a DM do the following as shown in Figure 

19: 

 

Á Log in as STUDENTXX 

Á Click on the Completion Status Tab 

 

Note: In the real work scenario, the estimated fields for the DM would most likely be filled in 

prior to work commencement, if not at creation. 

 

Á Locate the DM with Info Code ñ280ò as shown in Figure 19 

 

 

 
 

Figure 19.  The Completion Status Tab 

 

 

Á Double-click in the ESTIMATED HOURS data field 

Á Enter ñ300ò in the data field 

Á Use the drop down in the PERCENT COMPLETE  field and choose ñ25ò 

Á Scroll to the right, Double-click in the ESTIMATED START  field and Choose 

ñtodayôs dateò from the calendar interface 

Á Scroll to the right, Double-click in the ESTIMATED REVIEW field and Choose 

ñtodayôs date plus 1 weekò from the calendar interface 

Á Double-click in the ESTIMATED PUBLISH  field and Choose ñtodayôs date plus 

2 weeksò from the calendar interface 

Á Double-click in the ESTIMATED COMPLETE field and choose ñtodayôs date 

plus 2 weeks and 1 dayò from the calendar interface 

Á Click-off the record and the data will be saved 
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1.6.2 DM Priority 

 

EAGLE Publishing System incorporates a priority management system that allows specific 

ROLES the capability of indicating a work priority for the DM ranging from Not Identified (white 

or yellow) to High (RED). 

 

STEP To assign the current DM Medium Priority, do the following as shown and dexcribed: 

 

Á While logged in as STUDENTXX, navigate to the Data Modules tab. 

Á Locate the DM with Info Code ñ280ò as shown in (Figure 20) 

Á Right-click the DM and select Manage DM>>Set Priority 

 

 

Figure 20.  DMs Tab ï Set Priority 
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Figure 21.  Indication of ñHighò Priority 

 

Á Move the slide-bar to the right to indicate ñMediumò Priority (Figure 21) 

Á Choose OK  

Á Click-off the DM 

 

 

 

Figure 22.  DM Tab ï Meduim Priority (Orange) 

 

Note: As indicated in Figure 22the DM is now highlighted Orange to indicate its medium 

priority.  High priority, medium priority, and low priority are indicated by red, orange, 

and green backgrounds respectively.  DMs that are not assigned a priority are indicated 

by the standard yellow and white alternating line guides. 
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1.6.3 The ñNewô Status 

 

Immediately following a DMs creation, it is assigned the ñNewò status. This status is represented 

by a white page with a gold star for an icon in the Status section (Figure 23) 

 

 

 

Figure 23.  DM Tab - DM STATUS ñNewò. 

 

1.6.4 The ñAssignedò Status 

 

Following a DMs creation, it is assigned to a user for authoring. This status is represented by an 

icon depicting a person wearing a blue shirt ( ). 

 

 

 

Figure 24.  Data Modules Tab ï Assign Author 

 

STEP To assign an Author to a DM, do the following as shown and described: 

 

Á Navigate to the Data Modules Tab 

Á Locate the DM (s) to be assigned an Author as shown in Figure 24 with STATUS 

ñNewò. 

Á Ctrl-click both DMs 
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Note: We have selected both DMs. Both DMs will be assigned the same Author 

 

Á Right-click the DMs, and select Manage DM>>Assign Author (Figure 24) 

Á Select ñSTUDENTXXò from the drop down list that is displayed 

Á Choose OK  

Á Both DMs now show STATUS ñAssignedò (Figure 25) 

 

 

 

Figure 25.  Data Modules Tab ï STATUS Author Assigned 

 

1.6.5 The ñWork In Progressò Status 

 

The next step in the lifecycle of a DM is the ñWork in Progressò status. Generally speaking, from 

an Authoring viewpoint, WIP incorporates Checking the DM out, Editing, and then Checking the 

DM back in.  The WIP status is indicated by a blue book icon ( ). This status indicates that 

content is being added to the DM, and that it is not yet ready for review or publishing. A DM with 

this status may only be changed by its assigned Author, and this status may only progress by the 

assigned authorôs command (Checkout/Checkin). 

 

 

1.6.6 DM Checked Out 

 

The Checked Out status indicates that the DM is currently undergoing changes by the assigned 

author.  This status is indicated by a ñblue book with right facing green arrow iconò (Figure 

27).  It is recommended that, as an author, you only keep DMs checked out that you are currently 

working on.  This allows the EAGLE_TM_MGR_ROLE the ability to accurately assess progress 

being made on the DMs through the ñCompletion Statusò tab.  A Checked Out DM is not 

available for re-assignment.  This allows the EAGLE_TM_MGR_ROLE the ability to re-assign 

work to authors who may be able to take on additional assignments without interfering with a 

work in progress. 
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Figure 26.  Data Modules Tab ï Check Out 

 

 

STEP To check out an already assigned DM(s), do the following as shown and described: 

 

 

Á Click the Data Modules tab as shown in Figure 26 

Á Ctrl-Click the DMs with Info Code ñ007òand ñ030ò 

Á Right-click the DMs and select Check In/Out>>Check Out (Figure 26) 

Á The  STATUS icon changes to ña blue book with right facing green arrowò 

(Figure 27) 

 

 

 

Figure 27.  DMs TAB ï DM Checked Out Status 
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Figure 28.  DMs Tab ï Check In 

 

 

1.6.7 DM Checked In 

 

Following the editing of a DM the author will check it back in to show that it is again available for 

re-assignment or review.  This status is represented by ña blue book lacking the green arrowò 

( ) or ñWIPò. 

 

 

Note: You may Checkin multiple DMs at one time.  We will show Checking in only one DM at 

a time now so that we may introduce the Work Progress window. You will not  receive 

the Work Progress window when checking in more than one DM at a time. 

 

STEP  To check in a DM so that it can continue through the workflow lifecycle, do the 

following as shown and described: 

 

Á Locate the Data Module with Info Code ñ007ò as shown 

Á Right-click the DM, and select Author DM>>Check In as shown in Figure 28.  

The Work Progress pop up window is displayed (Figure 29) 
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Figure 29.  Work Progress ï Percent Complete 

 

 

Á Use the Percent Complete: dropdown and select ñ10%ò from the list 

 

 

 

Figure 30.  DMs Tab ï Status Checked In ñWIPò 

 

 

Á Choose OK .  The STATUS icon changes  to the blue book ñWIPò (Figure 30) 

 

Note: The IN WORK  number has incremented to ñ01ò. 

 

 

1.6.8 Analyzing a Data Module 

 

Please See Section 5.10 

 



EAGLE Publishing System Workbook for S1000D SECTION 1  INTRODUCTION 

1-27 

 

1.6.9 The Review Status 

 

The ñReviewò status is the next stage ï this is the stage in which quality checking takes place. 

Once an author believes he or she is finished with a DM, they assign the DM as ready for review. 

Following that, a user with EAGLE_REVIEWER_ROLE then checks the DM for completeness 

and decides whether the DM is ready to be approved, or needs to be re-worked. 

 

For this next STEP, the DM is completed by the author and is ready for review. 

 

 

 

Figure 31.  Change Status ï Review 

 

STEP To change the Status of the DM to Review, do the following as shown and described: 

 

Á Locate the DM with Info Code ñ042ò (Figure 31) 

Á Right-click the DM and select Change Status>>Review  
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Figure 32.  EPS:No Reviewer 

 

Á If no reviewer had been assigned, the EPS::No Reviewer window is displayed 

(Figure 32) 

 

Note: Keep in mind that the assignment of a reviewer can be performed at any point in the DMs 

life cycle, and many times will be assigned immediately. 

 

 

Figure 33.  Reviewer window - STUDENTXX 

 

Á Use the drop down to and select ñSTUDENTXXò as shown in Figure 33 

Á Choose OK   

Á With the Data Modules tab selected in the Main Screen, note that the STATUS icon 

has changed ( ) to indicate that the author can no longer edit this DM until it is 

reviewed) 
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1.6.10 The Rework Status 

 

Info: The reviewer has the option to send a DM back for additional work/rework.  This can be 

used for adding additional information or correcting errors that may be present within the 

DM.   

 

 

STEP To set the DM to the ñReworkò status, do the following as shown and described: 

 

Á In the EPS Main Screen with the Data Modules tab selected, Right-click the DM 

with Info Code ñ042ò as shown in Figure 34  

 

 

 

Figure 34.  DM STATUS Icon - Rework 

 

Á Choose Change Status>>Rework.  The Comments for (DM) Window is 

displayed (Figure 35) 

 

 

Note: You may select more than one DM and Change Status to Rework, but you will not 

receive the Comments window!  Section 5.13 DATA MODULE COMMENTS  covers 

commenting in detail. 
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Figure 35.  Comments for (DM) window 

 

 

Figure 36.  Comments for (DM) window ï Add Comment Section 

 

Á Enter ñTraining Class Projectò in the Comment section of the window (Figure 36) 

Á Choose  ñSubmitò  

Á Close the Comments for (DM) window  

 

Á The status symbol of the DM is now a green looping arrow  indicating that it is 

available to an assigned author for rework 
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1.6.11 Versions of a DM 

 

EPS retains up to ten previous version of a DM.  The version number is incremented each time a 

DM is checked-out.  The version history of a DM can be displayed and users may also ñroll backò 

the version of a DM. 

 

The DM STATUS must be ñChecked Outò to do the following. 

 

 

 

Figure 37.  Data Modules Tab - History 

 

1.6.12 Displaying Previous Versions of a DM 

 

STEP To view a previous version of a DM, do the following as shown and described 

 

Á Right-click the ñ042ò DM and choose History  as shown in Figure 37.  The EAGLE 

Rollback Viewer is displayed (Figure 38).  Figure 38 is displayed after the Backup: 

drop down has been activated 
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Figure 38.  EAGLE Rollback Viewer ï Backup: drop down list 

 

Á Select the version Date/Time from the Backup: drop down list to view the Roll 

Back XML vs the Current XML (Figure 38) 

 

 

1.6.13 Rolling Back a DM to a Previous Version 

 

STEP To Roll Back a version of a DM to a previous version, do the following as shown and 

described: 

 

Á With the EAGLE Rollback Viewer displayed and as shown in (Figure 38) ,note the 

Roll Back button at the top of the screen is in active  

Á Return to the EPS Main Screen and change the DM STATUS to either WIP or 

Checked out  

Á Return to the EAGLE Rollback viewer 

Á Select the version Date/Time from the Backup: drop down list 

Á Choose the Roll Back button  at the top of the EAGLE Rollback 

Viewer window 
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1.6.14 The ñApprovedò Status 

 

The approved status shows that the DM has been signed off on by the reviewer and is ready for 

publishing.  If a DM is in the ñapprovedò state it may still be sent back to the author for reworking 

without creating a new revision, however it is deemed ready for publishing. The approved status is 

represented by a gold medal on a green ribbon (Figure 40). 

 

STEP To assign the DM ñApprovedò Status, do the following: 

 

Á Set the DM with Info Code ñ030ò to Review  

 

 

Figure 39.  Data Modules Tab ï Change Status>>Approved 

 

Á Right-click the DM and select Change Status>>Approved as shown in Figure 39 

 

 

Figure 40.  DM STATUS - Approved 
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1.6.15 The ñPublished:ò Status 

 

Once approved, a DM may be set to Published, forcing a revision to be required in order to edit 

the DM further. 

 

 

 

Figure 41. Validation /Verification ï First Verification  

 

 

STEP To set the DM Status to Published, do the following as shown and described: 

 

Á Log in to the EAGLE Publishing System using the user STUDENTXX.  This user 

has been assigned the Author Role!! 

Á Navigate to in the DMs tab  

Á Right-click the DM with ñApproved Statusò and select Change 

Status>>Published.  The Validation /Verification window is displayed (Figure 41) 
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Figure 42. Validation/Verification ï Second Verification  

 

 

Á Click the Second Verification checkbox as shown in Figure 42 

Á Choose the OK  button   
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Figure 43.  DMs Tab - STATUS Published 

Á The DM is redisplayed with the STATUS icon changed to Published () as shown 

in Figure 43.  Note ISSUE NO equals ñ001ò and IN WORK  number has gone to 

ó00ò 
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SECTION  2 PROJECT SETUP 

 

2.0 INTRODUCTION 

 

At the forefront of the EAGLE Publishing System is an innovative solution for creating, editing, 

and managing multiple projects.  

 

The EAGLE Publishing Systemôs main tree structure is adapted from the SNS of the S1000D 

specification. The SNS allows for a hierarchal ordering of DMs. The easiest way to visualize this 

could be to imagine a mechanical system such as a bicycle. At the very top level of the SNS would 

be the bicycle itself (this would be the end item, to use the parlance of EAGLE.) The bicycle itself 

however is comprised of parts ï we could easily break this into three separate parts, the support for 

carrying the rider, the drive train for providing power to the wheels, and the control system for 

steering the bicycle. 

 

Whether or not EAGLE will be utilized for its vast Task Analysis Functionality in the creation of 

Procedural DMs, the first step in utilizing the EAGLE Publishing System either Standalone or 

with EAGLE is to make sure End Item defaults are set properly, an End Item record is established 

in Table XA and Cage Codes are established in Table XH. 

 

2.0.1 Project Setup and the Data Module Requirements List (DMRL) 

 

Identifying the items that will be documented and the type of information that is required is the 

first step in producing a draft DMRL 

 

Information Sets identify the data groups that are required 

Maintenance Significant Items (MSI) (could come from LSAR LCNs) 

Maintenance Policy and Task list (could come from the LSA19 report) 

Develop the indentured SNS for the product breakdown 

Determine the required Information Codes 

Generate a draft list of data modules (draft DMRL) required to produce the Information 

Sets 

 

When you create the project in the CSBD, use the agreed upon project Business Rules. 

  

Establish Model Identifier, S1000D version, baseline SNS 

Tailor the SNS for the product breakdown (using draft DMRL) 

Tailor the Information Codes for the project (using the draft DMRL) 

Create the Data Modules in the CSDB ready for authoring, may have been created by the 

EAGLE LSAR and contain task narratives 
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2.1  SETTING/VIEWING SYSTEM DEFAULT SETTINGS IN EAGLE 

 

Generally speaking, the System Defaults will be set for the specific DB and is not directly a part of 

EPS Project Setup.  It is mentioned here as only a check to ensure your system is operating per the 

desired specification. 

 

 

 

Figure 44.  EAGLE Login ï User Name: EAGLE 

 

 

2.1.1 Logging in to EAGLE 

 

To launch EAGLE from the START Menu you may select Programs>>EAGLE.  

 

As shown in Figure 44, a User Name: of ñEAGLEò and a User Password: have been entered.  

This data will be used to log the User into the specific Database Server.  You must login as 

EAGLE to view /set System Default Settings. 

 

The EAGLE executable ( ) resides in the EAGLE Install Directory.  A shortcut Icon 

can be utilized to launch EAGLE. 
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Figure 45.  System Defaults Window - Specification Type 2B 

 

 

2.1.2 System Default Settings MIL-STD-1388-2B 

 

STEP To set or view System Defaults, do the following from the EAGLE Navigator as shown 

and described: 

 

Á Launch EAGLE and Login as EAGLE as shown in Figure 44 

Á Choose  the Administration Discipline by clicking on it  

Á Choose the System Defaults Function by double clicking on it.  The System 

Defaults window is displayed (Figure 45) or (Figure 46) 

 

As shown in Figure 45, the Specification Type has been set to MIL-STD-1388-2B, and the 

Country Code has been set to USA (United States of America) 
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Figure 46.  System Defaults Window - Specification Type 00-60 

 

2.1.3 System Default Settings DEF STAN 00-60 

 

As shown in Figure 46, the Specification Type has been set to DEFSTAN 00-60, and the Country 

Code has been set to DEF-STAN 00-60 ISSUE 5. 
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2.2 CREATING END ITEM DEFAULTS IN EAGLE 

 

2.2.1 End Item Defaults MIL -STD-1388-2B 

 

STEP To create an End Item Default record in EAGLE, do the following as shown and 

described: 

 

Á Launch EAGLE and Login as EAGLE or SU as shown in Figure 44 

 

 

Figure 47.  End Item Defaults ï MIL -STD-1388-2B 

 

Á From the Navigator select Administration>>End Item Defaults .  Figure 47 is 

displayed.  Figure 47 is shown with data entered 

Á Activate the window by left clicking in the gray area (This positions the curser for 

the insert) 

Á Choose Insert on the main toolbar 

Á Enter ñBICYCLEXXò in the  End Item data field 

Á Use the drop down lists for the appropriate data fields and fill in the data as shown 

for Data Module Spec Type, Publishing System, EAGLE Publishing System 

Project and Data Module Issue 

Á Choose the Save button on the main toolbar 

 

2.2.2 End Item Defaults DEF STAN 00-60 

 

STEP To create an End Item Default record in EAGLE, do the following as shown and 

described: 

 

Á Launch EAGLE and Login as EAGLE or SU as shown in Figure 44 
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Note: When operating as 00-60 and importing fullfile, Def Stan 00-60 Issue Number must be 

entered in the data field.  In this case Issue Number of End Item is 5 as shown in Figure 

48. 

 

Á Activate the window by left clicking in the gray area (This positions the curser for 

the insert) 

Á Choose Insert on the main toolbar 

Á Enter ñBICYCLEXXò in the End Item data field 

Á Use the drop down lists for the appropriate data fields and fill in the data as shown 

in Figure 48 for Data Module Spec Type, Publishing System, EAGLE 

Publishing System Project and Data Module Issue 

 

Note: Selecting óYESô from the Use SGML Narrative Editor drop down list will ensure the 

XML Editor associated with XML editing will be invoked upon editing in the EAGLE 

Narrative Editor window. 

 

 

Á Choose the Save button on the main toolbar 

 

 

 

Figure 48.  End Item Defaults ï DEF ï STAN 00-60 

 

 

2.3 CREATING AN END ITEM RECORD IN TABLE XA  

 

This STEP in not necessary if you are utilizing EAGLE LSAR data and a fullfile has been 

imported.  For the purposes of the EAGLE Training class, this fullfile data will already have been 

imported. 
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Figure 49.  LCN Maintenance ï End Item (XA) Maintenance 

 

STEP To create an End Item record in table XA do the following from the EAGLE Navigator as 

shown in Figure 49: 

 

 

Á In EAGLE logged in as EAGLE or SU choose LCN Maintenance>>End Item 

(XA) Maintenance 
Á Double-click the End Item (XA) Function  or choose Execute from the Main 

Toolbar.  The End Item Data Maintenance window is displayed (Figure 50) 
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Figure 50.  End Item Data Maintenance - BICYCLEXX 

 

Á In the End Item Data Maintenance window (Figure 50) left click in the gray area of 

the window.  (This positions the curser for the insert) 

Á Choose Insert on the main toolbar 

 

Note: The End Item ñBICYCLEXXò is used only for example.  When used as part of Eagle 

Training in a classroom, a Fullfile has most likely been imported and the XA Record is 

already present.  The ñXXò is normally replaced with two digits ie. 01, 09, 11, 21 etc. 

 

Á Enter ñBICYCLEXXò for End Item and ñ42222222ò for LCN Structure  as shown 

in (Figure 50) 

Á Choose Save on the main toolbar 
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Figure 51.  LCN Maintenance ï CAGE Code (XH) Maintenance 

 

 

2.4 CREATING XH RECORDS IN EAGLE 

 

For EPS to function as designed, Cage Codes must be resident in Table XH of the database. 

 

 

STEP To create CAGE Codes in Table XH do the following from the EAGLE Navigator as 

shown and described: 

 

Á Make sure the correct End Item is selected 

Á Double-click the CAGE Code (XH) Maintenance function or select it and choose 

the Execute button on the main toolbar.  The CAGE Code Data Maintenance 

window is displayed 
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Figure 52.  CAGE Code Data Maintenance ï CAGE 15090 

 

 

Á Click in the gray area of the window (lower portion) 

Á Choose Insert from the main toolbar 

Á Enter the data as shown in Figure 52 

Á Choose Save on the main toolbar.  Minimize or Exit EAGLE 
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2.5 CREATING PROJECTS IN EAGLE PUBLISHING SYSTEM 

 

To create a project in EPS, you must be logged in as the EAGLE user, or have the TM Manager 

role granted to your user ID.  At the current time, the EPS executable ( ) resides 

in the EAGLE Install Directory.  A shortcut icon can be utilized to launch EPS. 

 

STEP To create a Project in EPS, do the following from the EPS EAGLE Login screen as 

shown and described: 

 

Á At the EAGLE Login window (Figure 53) enter your correct information  

Á Choose OK.  Figure 56 may be displayed 

 

 

 

Figure 53.  EAGLE Login - EPS 
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Figure 54.  EPS: No End Item Selected window 

 

Á Choose OK to acknowledge No End Item Selected.  The End Item Select window is 

displayed 

 

 

Figure 55.  End Item select window 

 

 

Á Select your BICYCLEXX End Item from the drop down list as shown in Figure 54 

Á Choose OK .  The EPS: No Projects window is displayed 
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Figure 56.  EPS: No Projects window 

 

 

Á Choose OK to acknowledge No Projects.  The EAGLE Publishing System Main 

Screen is displayed 

 

 

 

Figure 57.  EPS ï Manage Projects 

 

 

Á Choose Project->Manage Projects from the main toolbar (Figure 57) or click on 

the Manage PRJs icon just below the toolbar as shown in Figure 58 
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Figure 58.  EPS ï Manage PRJs 

 

Á The Manage Projects window is displayed (Figure 59) 

 

 

Figure 59.  Manage Projects ï New 

 

Á Choose the New  button.  The New Project window is displayed (Figure 

60).  Figure 60 is shown with Project created  
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Figure 60.  New Project window ï Information Entered 

 

Á Values from various drop down lists will  be defaulted (Figure 60) 

Á Enter ñTRAININGXXò for Project Name and ñBICYCLEXX TRAINING 

PROJECTò for Project Description 

Á Enter ñBICYCLEXXò for Model Identification  

Á Enter  ñAAAò for System Difference Code (SDC) 

Á Select ñD - Info on all 3 locations A,B, and Cò from the Item Location Code drop 

down list 

Á Enter ñRò for Responsible Partner Company (RPC) Code 

Á Enter ñ15090ò for RPC CAGE and Originator CAGE  by entering a ñ1ò and then 

selecting from the drop down list 

Á Check the two checkboxes at the bottom of the screen, Track Percent Complete 

and Create Default Brex 

Á Choose the OK  button 
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Á Choose OK  to New Project created message 

Á Close the Manage Projects window 

Á The EPS main screen will be redisplayed with the  BREX DM in the data (Figure 

61) 

 

 

 

Figure 61.  Data ModulesTab ï BREX DM  

 

 

STEP Create a second Project in EPS ñTRAINING2XX, following the instructions from the 

previous STEP.  Use SDC of ñAAAAò, choose ñA ï Info on items installed on the 

Productò from the Item Location Code drop down list and use ñBò for Responsible 

Partner Company (RPC) Code and RPC CAGE and Originator CAGE  of ñ99999ò.  Be 

sure to Click OK .  Close the Manage Projects window.  This Project will be deleted later 

on:  

 

 

2.6 CUSTOMIZING THE SNS 

 

 

Note: The SNS can only be modified by the EAGLE user ID or a user ID granted the TM 

Manager role. 

 

2.6.1 Creating a New Project Node 

 

STEP To create a new project node, do the following as shown and described: 

 

Á From the EPS Main Screen, Choose Project>>Manage Projects.  The Manage 

Projects window is displayed 

Á Make sure your TRAININGXX Project is selected 
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Figure 62.  Edit Project ï SDC AAA 

 

 

Á Choose Edit.  The Edit Project window is displayed 

Á Click the expand icon to the left of ñBICYCLEXXò MI then  SDC ñAAAò then 

Click on SDC ñAAAò as shown in Figure 62 

 

 

 

Figure 63.  Project Node ï Code 13 

 

Á Use the scroll bar at the right of the Project Node section of the window (lower 

right) and Click on the row with Code ñ13ò and Description ñNot Givenò as shown 

in Figure 63 
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Figure 64.  Project Node ï Buttons Active 

 

Á Edit the Description for Code ñ13ò  to read ñPropulsion systemò as shown in 

Figure 64 

Á Click the OK  button 

Á The Edit Project window should close automatically 

 

 

2.6.2 Editing an Existing Project Node 

 

 

Figure 65.  EPS Main Menu ï Edit SNS 
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STEP To edit an existing project node, do the following as shown and described: 

 

Á Select Project>>Manage SNS>>Edit as shown in Figure 65.  The Edit Project 

window is displayed (Figure 66) 

 

 

Figure 66.  Edit Project window ï Details Tab 

 

 

 

Figure 67.  Edit Project window ï Node 13 Propulsion system 

 

Á Use the expand icons to access node 13 Propulsion system (System Level of SNS) 

just created in 2.6.1 as shown in Figure 67.  Note Code ñ00ò and Description ñNot 

givenò is displayed in the Project Node section of the window 
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Figure 68.  Edit Project ï Node 13 Propulsion system expanded 

 

Á Use the expand icons as shown in Figure 68 to expand the nodes under 13 Propulsion 

system 
 

 

 

Figure 69.  Edit Project window ï Edit node 

 

Á In the Project Node section of the window, edit the Description of Code ñ00ò to read 

ñPropulsion system - generalò as shown in Figure 69 

  

Note: When you click in the Project Node section and enter ñPropulsion system - generalò, the 

blue cursor in the SNS area has dropped down to indicate which level you are editing. 
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Figure 70.  Edit Project ï Project Node Code 00 

 

Á Click off the row and note that the first node under 13 Propulsion system in the SNS has 

changed to read ñ00 Propulsion system - generalò (Figure 70) 

 

 

 

Figure 71.  13 Propulsion system - added 

 

 

STEP To continue editing an existing project node, do the following as shown and described: 

 

Á Click on the ñ13-00 Propulsion system ï generalò level and edit ñNot givenò to 

ñGeneralò.  Then Click on the newly edited ñ00 Generalò and edit that ñNot givenò to 

ñGeneralò as shown in Figure 71 

 

 

 

Figure 72.  13 Propulsion system node - Edited 

 

Á Next, Click on the 13Propulsion system level and add a new Project Node Code ñ10ò 

with Description ñPedal assemblyò as shown in Figure 72 

Á Click on the newly added node ñ10 Pedal assemblyò and edit  code ñ00ò Description to 

ñPedal assembly ï generalò 

Á Click on the Propulsion system node 13 
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Figure 73.  Pedal assembly added 

 

At this point your screen should reflect Figure 73.  When doing this as an exercise, please contact 

the instructor if you do not achieve these results. 

 

STEP To continue editing an existing project node, do the following as shown and described: 

 

Á Click the ñ10 Pedal assemblyò node in the SNS 

Á In the Project Node section add Code ñ05ò with  Description ñLeft pedal ñand add 

Code ñ08ò with Description ñRight pedalò 

Á Click on the Propulsion system node 13 

 

 

Figure 74.  Pedal assembly ï Left and Right Pedal added 

 

At this point your screen should reflect Figure 74.  When doing this as an exercise, please contact 

the instructor if you do not achieve these results. 

 

Á Click the OK  button 
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2.7 ADDING/EDITING INFORMATION CODES 

 

Information codes are used to identify the type of information contained in the DM.  Codes that 

are identified as "Not given" are available for use, as necessary, for projects to allocate their own 

definitions. 

 

 

 

Figure 75.  Manage Info Codes ï Edit 

 

2.7.1 Adding an Information Code 

 

STEP Do the following as shown (Figure 75) and described to add a new Information Code: 

 

Á From the Main Menu, Choose Project>>Manage Info Codes>> Edit.  The Edit 

Information Codes  screen is displayed (Figure 76) 
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Figure 76.  Edit Information Codes window 

 

Á Scroll down if necessary and Click on the record with INFO CODE  of  ñ007ò as 

shown in Figure 77 

Á Right-click the record and choose Add.  The Add Information Code window is 

displayed (Figure 77).  Figure 77 shown with the following data entered 
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Figure 77.  Add Information Code Window 

 

 

Á Enter ñ007ò in the Info Code field 

Á Enter ñBò in the Info Code Variant field 

Á Enter ñList of symbols and termsò in the Description field 

Á Choose ñDESCRIPTIVEò from the DM Types drop down list 

Á Choose OK   

 

 

2.7.2 Editing an Existing Information Code 

 

STEP Do the following as shown and described to edit an existing Information Code: 

 

Á From the Edit Information Codes  window (Figure 76), Select the record with 

INFO  CODE ñ007ò and VARIANT ñBò 

Á Click in the DESCRIPTION  field and edit the record to read ñlist of symbols terms 

and abbreviationsò 

Á Choose OK  

 

 

2.8 XML EDITORS 

 

EAGLE Publishing System utilizes your systemôs default XML editor. This is largely based on 

user preference.  For ease of training, all instructions for this workbook will be given with regards 

to Arbortext Editor. 

 

2.8.1 Associating Arbortext Editor 
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STEP Do the following to change your default XML editor to Arbortext Editor : 

 

Á Open Windows Explore (Right-click on the Start button and Select ñExploreò) 

Á Choose Tools>>Folder Options from the menu. 

Á Choose the File Types tab. 

Á Scroll down to the XML extension and click on the line.  Under ñDetails for óXMLô 

extensionò,  make sure Arbortext Editor for Window is selected for ñOpens with: 

Á Choose the Change button and select ñArbortext Editor for Windowsò if not already 

selected 

Á Choose the OK  button and close both of the windows. 

 

Note If you have chosen to change your default XML editor for the purposes of completing 

this workbook, the same steps can be taken to return to your former text editor. 

 

2.9 XML TEMPLATE 

 

XML Templates are used to define the initial XML contained in DMs at time of creation.  The 

XML templates can be used to control information that should be included in all DMs (for 

example, Export Control notices in the IDSTATUS SECTION). 

 

 

STEP Do the following to edit an XML template: 

 

 

 

Figure 78.  Data Module ï Edit XML Template 

 

Á From the Main Menu Select Data Module>>Edit XML Templates as shown in 

Figure 78.  The XML Template Editor window is displayed (Figure 79). 
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Figure 79.  XML Template Editor ï Select Data Module Type 

 

Á Select the schema for which the XML template is to be edited from the Data Module 

Type drop down list as shown in Figure 79.   In this case ñDescriptiveò has been 

selected 

Á Choose the Edit XML   button.  The Arbortext Editor is invoked 

(Figure 80) 

 



EAGLE Publishing System Workbook for S1000D SECTION 2  PROJECT SETUP 

2-30 

 

 

Figure 80.  Arbortext Editor ï Edit XML Template 

 

 

Note: If the Arbortext Editor does not display as shown in Figure 80 (with Tags displayed) and 

looks more like Figure 81, do the following STEP: 
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Figure 81.  XML Displayed ï Tags Off 

 

 

STEP Do the following to display the XML Tags in Arbortext Editor: 

 

Á From the right side of the Arbortext Editor Main Icon display (Figure 82), Choose 

the Tag Display Icon (Figure 83) 

 

 

 

Figure 82.  Arbortext Editor ï Icon Display Right side 
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Figure 83.  Arbortext Editor ï Tag Display Icon 

 

 

STEP Conôt.  Do the following to edit an XML template: 

 

 

Figure 84.  XmL Template ï datarest tag allowed 

 

 

Á Place your cursor after the word ñUnclassifiedò and hit the Return key as shown in 

Figure 84 

Á Click on datarest  

 

 

 

Figure 85. XML Template - Distribution 

 

 

Á Place your curser in ñdistribò tag and then enter the data ñTo be used only for 

EAGLE Publishing System Trainingò.  If your screen does not reflect Figure 85, 

please contact your Instructor 

Á Choose File>>Save 

Á Choose OK  to ñChanges have been saved to the databaseò 

Á You may either close the Arbortext Editor window and minimize Arbortext Editor or 

close the Arbortext Editor 

Á Close the XML Template Editor 
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2.10 DELETING A PROJECT 

 

 

 

Figure 86.  Manage Projects - Delete 

 

STEP To delete a project, do the following as shown and described: 

 

Á Choose Project->Manage Projects from the main toolbar.  The Manage Project 

window is displayed (Figure 86) 

Á Click on the ñTRAINING2XXò Project as shown 

Á Choose the Delete button from the Manage Projects window (Figure 86 ).  The EPS: 

Confirm Delete window is displayed (Figure 87) 

 

 

 

Figure 87.  EPS: Confirm Delete ï Press OK 

Á Press the OK  button 

Á Close the Manage Projects window 

 
































































































































































































































































































































